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Viewing files by category in Smart Album

1 In the thumbnail view, press [m].

2 Select Filter → a category, and then press [o].
* Default

Option Description

Type View files by the file type such as photo or video.

Date* View files by the date they were saved.

Week View files by the day of the week they were saved.

Location
View file by the place they were saved. (Only the 
photos captured with a GPS module have the 
location information.)

Viewing files as a folder
Continuous and  burst shots appear as a folder. Deleting a folder will 
delete all photos in the folder.

: Single View
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Protecting files
Protect your files from accidental deletion.

1 In Playback mode, press [m] → z → Protect → 
an option. (Single, Select, All)

2 Rotate the navigation button or press [C/F] to select a 
file, and then press [o].

3 Press [f].

Deleting files
Delete files in Playback mode and secure more space on your memory 
card. Protected files are not deleted.

Deleting a single file

You can select a single file and delete it.

1 In Playback mode, select a file, and then press [ ].

• Alternatively, in Playback mode, press [m] → z → 
Delete → Single.

2 When the pop-up message appears, select Yes.
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Deleting multiple files

You can select multiple files and delete them.

1 In Playback mode, press [ ] → Multiple Delete.

• Alternatively, in Playback mode, press [m] → z → 
Delete → Select.

2 Select files you want to delete by rotating the navigation 
button or pressing [C/F], and then press [o].

• Press [o] again to cancel your selection.

3 Press [ ].

4 When the pop-up message appears, select Yes.

Deleting all files

You can delete all files on the memory card at once.

1 In Playback mode, press [m].

2 Select z → Delete → All.

3 When the pop-up message appears, select Yes.
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Enlarging a photo
You can enlarge photos when viewing them in Playback mode. You can 
also use the Trim function to extract the portion of the image displayed 
on the screen and save it as a new file.

Magnified area

Magnification (the maximum 
magnification may differ by 
resolution) 

Full Image Trim

Press [o], and then rotate the navigation button clockwise 
to enlarge a photo.

(Rotate the navigation button counter-clockwise to reduce a photo.)

To Do this

Move magnified area Press [D/I/C/F].

Crop the enlarged image Press [f]. (saved as a new file)

Return to the original image Press [o].

Viewing a slide show
You can view photos in a slide show, apply various effects to the slide 
show, and play background music.

1 In Playback mode, press [m].

2 Select .

3 Select a slide show effect option.

• Skip to step 4 to start a slide show with no effects.

Option Description

Images

Set the photos you want to view as a slide show.
• All: View all photos in a slide show.
• Date: View photos captured on a specific date in 

a slide show.
• Select: View selected photos in a slide show.

Effect Select a transition effect. Select Off for no effects.

Interval Select the amount of time each photo is displayed.

Music Select a background music.

4 Select Slide Show → Play or Repeat.

• Slide show begins right away.

Viewing photos
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Auto rotating
With Auto Rotate on, the camera automatically rotates photos you have 
captured vertically so they fit the screen horizontally.

To set auto rotate 
options,  In Playback mode, press [m] → x → Auto Rotate 

→ an option.

Setting the thumbnail mode
You can select the number of files to view in the thumbnail mode.

To set thumbnail 
mode options,  In playback mode, press [m] → x →  

Thumbnail mode → an option.
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You can play a video, capture an image from a video, or crop a video.

Pause Stop

Video viewing controls

To Do this

Rewind
Press [C].
Scan backward in 2X, 4X, and 8X increments 
each time you press [C]. 

Pause/Play Press [o].

Fast forward
Press [F].
Scan forward in 2X, 4X, and 8X increments each 
time you press [F].

Volume control Rotate the navigation button to the left or right.

Stop Press [D].

Trimming a video during playback

1 Press [o] at the point where you want the new video to 
begin.

2 When paused, press [ ].

3 Press [o] at the point where you want the new video to 
end.

4 When paused, press [ ].

5 When the pop-up message appears, select Yes.

The cut file is saved as a separate file under a new name.

Playing videos



97

Playback/Editing > Playing videos

Capturing an image during playback

1 Press [o] at the point where you want to save a still 
image.

2 Press [I].

• The resolution of the captured image is the same as the video resolution.
• The captured file is saved as a separate file under a new name.
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Perform photo editing tasks, such as resizing, rotating, eliminating  
red-eye effects, and adjusting brightness, contrast, or saturation.  
Edited photos are saved as new files under different file names.  
3D photos, panoramic photos, and 3D panoramic photos cannot be 
edited with the Image Edit function.

To set Image Edit 
options,  In Playback mode, press [f] → an option.

Options
* Default

Icon Description

Smart Filter: Apply various filter effects to photos and create 
unique images. (Off*, Miniature, Soft Focus, Old Film 1,  
Old Film 2, Halftone Dots, Sketch, Fish Eye, Defog, 
Negative)

The new file may be smaller than the original.

Red-eye Fix: Remove red-eyes on a photo. (Off*, On)

The new file may be smaller than the original.

* Default

Icon Description

Backlight: Correct the brightness of an underexposed photo. 
(Off*, On)

Before correction After correction

The new file may be smaller than the original.

Resize: Resize the size of a photo.

The available resolutions may differ depending on the size of 
the selected photo.

Rotate: Rotate a photo. (Off*, Right 90˚, Left 90˚, 180˚, 
Horizontal, Vertical)

You cannot rotate protected files or RAW files.

Editing photos
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* Default

Icon Description

Face Retouch: Hide facial imperfections.

The new file may be smaller than the original.

Brightness: Adjust the brightness of a photo.

The new file may be smaller than the original.

Contrast: Adjust the sharpness of a photo.

The new file may be smaller than the original.

Vignetting: Apply the retro-looking colors, high contrast,  
and strong vignette effect of Lomo cameras.

The new file may be smaller than the original.

 



Chapter 4
Wireless network

Learn how to connect to wireless local area networks (WLANs) and use functions.
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Connecting to a WLAN and configuring network settings

Learn to connect via an access point (AP) when you are in a range of a 
WLAN. You can also configure network settings.

Connecting to a WLAN

1 Rotate the mode dial to B.

2 Select , , , , or .

3 Press [m], and then select Wi-Fi Setting.

• In some modes, press [m] or follow the on-screen 
instructions until the Wi-Fi Setting screen appears.

• The camera automatically searches for available AP devices.

4 Select an AP.

Wi-Fi Setting

Exit Manual

Refresh

Samsung 1

Samsung 2

Samsung 3

Samsung 4

Icon/Option Description

Refresh Refresh connectable APs.

Ad hoc AP

Secured AP

WPS AP

Signal strength

WPS button connection Connect to a WPS AP.

Add wireless network Add an AP manually.

• Press [f] to open network setting options.

• When you select a secured AP, a pop-up window appears. Enter 
the required passwords to connect to the WLAN. For information 
about entering text, refer to "Entering text". (p. 105)

• When a login page appears, refer to "Using the login browser". 
(p. 103)

• When you select an unsecured AP, the camera will connect to the 
WLAN.

• If you select a WPS profile supported AP, select WPS PIN 
connection, and then enter a PIN on the AP device. You can 
also connect to a WPS profile supported AP by selecting WPS 
button connection on the camera, and then pushing the WPS 
button on the AP device.
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Setting network options

1 In the Wi-Fi Setting screen, move to an AP, and then  
press [f].

2 Select each option and enter the required information.

Option Description

Authentication Select a network authentication type.

Data Encryption Select an encryption type.

Network Key Enter the network password.

IP Setting Set the IP address manually.

Manually setting the IP address

1 In the Wi-Fi Setting screen, move to an AP, and then  
press [f].

2 Select IP Setting → Manual.

3 Select each option, and then enter the required 
information.

Option Description

IP Enter the static IP address.

Subnet Mask Enter the subnet mask.

Gateway Enter the gateway.

DNS Server Enter the DNS address.
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Using the login browser
You can enter your login information via the login browser when 
connecting to some APs, sharing sites, or cloud servers.

Button Description

[D/I/o/F] Move to an item or scroll the page.

[o] Select an item.

[m]

Access the following options:
• Previous Page: Move to the previous page.
• Next Page: Move to the next page.
• Reload: Reload the page.
• Stop: Stop loading the page.
• Exit: Close the login browser.

[ ] Close the login browser.

• You can reduce or enlarge a web page by rotating the navigation button.
• You cannot select some items depending on the page you connected to. 

This does not indicate a malfunction.
• The login browser may not close automatically after you log into some 

pages. If this occurs, close the login browser by pressing [ ], and then 
proceed with the desired operation.

• It may take longer to load the login page due to the page size or network 
speed. If this occurs, wait until the login information input window appears.
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Network connection tips
• The quality of the network connection will be determined by the AP.

• The further the distance between your camera and the AP, the longer 
it will take to connect to the network.

• If a nearby device is using the same radio frequency signal as your 
camera, it may interrupt your connection.

• If your AP name is not in English, the camera may not be able to 
locate the device or the name may appear incorrectly.

• For network settings or a password, contact your network 
administrator or network service provider.

• If a WLAN requires authentication from the service provider, you may 
not be able to connect to it. To connect the WLAN, contact your 
network service provider.

• Depending on the encryption type, the number of digits in the 
password may differ.

• A WLAN connection may not be possible in all surroundings.

• The camera may display a WLAN enabled printer on the AP List.  
You cannot connect to the network via a printer.

• You cannot connect your camera to a network and a TV 
simultaneously. Also, you cannot view photos or videos on a TV while 
connected to a network.

• Connecting to a network may incur additional charges. Costs will vary 
based on the conditions of your contract.

• If you cannot connect to a WLAN, try another AP from the available AP 
list.

• You can also connect to free WLANs in some foreign countries.

• A login page may appear when you select free WLANs provided 
by some network service providers. Enter your ID and password to 
connect to the WLAN. For information about registering or the service, 
contact the network service providers.

• Be cautious when you enter personal information for an AP connection. 
Do not enter any payment or credit card information on your camera. 
The manufacturer is not liable for any problem caused by entering such 
information.

• Available network connections may differ by country.

• The WLAN feature of your camera must comply with radio transmission 
laws in your region. To ensure compliance, use the WLAN feature only 
in the country where you purchased the camera.

• The process for adjusting network settings may differ, depending on 
network conditions.

• Do not access a network that you are not authorized to use.

• Before you connect to a network, ensure your battery is fully charged.

• When a DHCP server is not available you must make an autoip.txt file 
and copy it to the inserted memory card to connect to the network 
using Auto IP.
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Entering text
Learn how to enter text. The icons in the table below let you move the 
cursor, change the case, etc. Use the navigation button to scroll to a 
desired key, and then press [o] to enter the key.

Back Backspace

Done

Icon Description

Delete the last letter.

Move the cursor.

In ABC mode, change the case.

Enter ".com".

Switch between Symbol mode and ABC mode.

Enter a space.

Done Save the displayed text.

View the entering text guide.

• You can enter only English alphabets, regardless of the display language.
• To move to Done directly, press [y].
• You can enter up to 64 characters.



106

Wireless network

The camera connects to a smart phone that supports the MobileLink 
feature via a WLAN. You can easily send photos or videos to your smart 
phone.

•	 The MobileLink feature is supported by Galaxy series smart phones with 
the Android 2.2 OS or higher. If your smart phone uses the Android 2.1 
OS, upgrade your smart phone to Android 2.2 or higher. This feature is 
also supported by 7 and 10.1 inch Galaxy Tab.

•	 You should install the Samsung MobileLink application on your phone or 
device before using this feature. You can download the application from 
Samsung Apps or Android market.

•	 When there are no files in the camera memory, you cannot use this feature.
•	 You can view up to 1,000 files and send up to 100 files at a time.
•	 You cannot send RAW files.

1	 On the camera, rotate the mode dial to B.

2	 On the camera, select .

•	 If the pop-up message that prompts you to download the 
application appears, select Next.

3	 On the camera, select All Images or Selected Images to 
select files to share with the smart phone.

•	 Only the selected files will be displayed on the smart phone.

•	 If you Selected Images, select Share on the camera after 
selecting files to share.

4	 On the smart phone, turn on the Samsung MobileLink 
application.

•	 Read the on-screen instructions carefully to select and connect 
to your camera.

•	 The smart phone can connect to only one camera at a time.

5	 On the camera, select Yes.

6	 On the smart phone, select files to send from the camera 
to the smart phone.

7	 On the smart phone, select Copy.

•	 The camera will send the files.

Sending photos or videos to a smart phone
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The camera connects to a smart phone via a WLAN. Use the smart 
phone as a remote shutter release with the Remote Viewfinder feature. 
The captured photo will display on the smart phone.

•	 The Remote Viewfinder feature is supported by Galaxy series smart phones 
with the Android 2.2 OS or higher. If your smart phone uses the Android 2.1 
OS, upgrade your smart phone to Android 2.2 or higher. This feature is also 
supported by 7 and 10.1 inch Galaxy Tab.

•	 You should install the Remote Viewfinder application on your phone or 
device before using this feature. You can download the application from 
Samsung Apps or Android market.

1	 On the camera, rotate the mode dial to B.

2	 On the camera, select .

•	 If the pop-up message that prompts you to download the 
application appears, select Yes.

3	 On the smart phone, turn on the Remote Viewfinder 
application.

•	 Read the on-screen instructions carefully to select and connect 
to your camera.

•	 The smart phone can connect to only one camera at a time.

4	 On the smart phone, set the following shooting options.

Icon Description

Flash option

Timer option

Photo size

•	 While using this feature, some buttons are not available on your 
camera.

•	 The zoom button and the shutter button on your smart phone will 
not function when using this feature.

•	 Remote Viewfinder mode supports the  and  photo sizes 
only.

Using a smart phone as a remote shutter release
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5 On the smart phone, touch and hold  to focus.

• The focus is automatically set to multi-AF.

6 Release  to capture the photo.

• The photo will be saved in your camera.

• Touch the photo at the bottom of the screen to save it to the 
smart phone. If you have captured a photo with the  photo 
size, the photo will be resized to 1616X1080. If you have 
captured a photo with the  photo size, the photo will be 
resized to 640X360.

• When you use this feature, the ideal distance between the camera and the 
smart phone may vary, depending on your surroundings.

• The smart phone must be within 7 m of the camera to use this feature.
• It will take some time to capture the photo after you release  on the 

smart phone.
• The Remote Viewfinder function will deactivate when:

 - there is an incoming call on the smart phone
 - either of the camera or the smart phone turn off
 - the memory is full
 - either device loses connection to the WLAN
 - the Wi-Fi connection is poor or unstable
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Upload your photos or videos to file sharing websites. Available 
websites will be displayed on your camera.

Accessing a website

1 Rotate the mode dial to B.

2 Select .

3 Select a website.

• The camera will automatically attempt to connect to a WLAN via 
the most recently connected AP device.

• If the camera has not previously been connected to a WLAN,  
it will search for available AP devices. (p. 101)

4 Enter your ID and password, and then select Login.

• For information about entering text, refer to "Entering text".  
(p. 105)

• To select an ID from the list, select  → an ID.

• If you have previously logged in to the website, you may be 
logged in automatically.

You must have an existing account on the file sharing website to use this 
feature.

Uploading photos or videos

1 Access the website with your camera.

2 Scroll to the files you want to upload, and then press [o].

• You can select up to 20 files. The total size must be 10 MB or 
less.

3 Select Upload.

• If you connected to Facebook, select Upload → Upload.

• If you connected to Facebook, you can enter your comments by 
selecting the Comment box. For information about entering text, 
refer to "Entering text". (p. 105)

Using photo or video sharing websites
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• You cannot upload RAW files.
• You can upload up to 20 files at a time.
• The maximum photo resolution you can upload is 2M, and the longest 

video you can upload is a video recorded using . If the selected photo 
resolution is higher than 2M, it will be automatically resized to a lower 
resolution. If you connected to Facebook, the photo resolution will be 
resized to 1M resolution.

• The method of uploading photos or videos may differ depending on the 
selected website.

• If you cannot access a website because of firewall or user authentication 
settings, contact your network administrator or network service provider.

• Uploaded photos or videos may be automatically titled with the date they 
were captured.

• The speed of your internet connection may affect how quickly photos 
upload or web pages open.

• When there are no files in the camera memory, you cannot use this feature.
• You can also upload photos or videos to file sharing websites in Playback 

mode by pressing [m], and then selecting z → Share(Wi-Fi) →  
a desired website.
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You can change settings in the email menu, and send photos or videos 
stored on the camera via email.

Changing email settings
In the email menu, you can change settings for storing your information. 
You can also set or change the email password. For information about 
entering text, refer to "Entering text". (p. 105)

Storing your information

1 Rotate the mode dial to B.

2 Select .

3 Press [m].

4 Select  → Sender Setting.

5 Select the Name box, enter your name, and then select 
Done.

Sender Setting

Name

Back

Email

Save Reset

6 Select the Email box, enter your email address, and then 
select Done.

7 Select Save to save your changes.

• To delete your information, select Reset.

Sending photos or videos via email
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Setting an email password

1 Rotate the mode dial to B.

2 Select .

3 Press [m].

4 Select  → Setting Password → On.

• To deactivate the password, select Off.

5 When the pop-up appears, press [o].

• The pop-up disappears automatically even if you do not  
press [o].

6 Enter a 4-digit password.

7 Enter the password again.

8 When the pop-up appears, press [o].

• The pop-up disappears automatically even if you do not  
press [o].

If you lost your password, you can reset it by selecting Reset on the 
password setting screen. When you reset the information, previously saved 
user’s setting information, email address, and recently sent email list will be 
deleted.

Changing the email password

1 Rotate the mode dial to B.

2 Select .

3 Press [m].

4 Select  → Change Password.

5 Enter your current 4-digit password.

6 Enter a new 4-digit password.

7 Enter the new password again.

8 When the pop-up appears, press [o].

• The pop-up disappears automatically even if you do not  
press [o].
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Sending photos or videos via email
You can send photos or videos stored on the camera via email.  
For information about entering text, refer to "Entering text". (p. 105)

1 Rotate the mode dial to B.

2 Select .

3 Select the Sender box, enter your email address,  
and then select Done.

• If you have previously saved your information, it will be inserted 
automatically. (p. 111)

• To use an address from the list of previous recipients, select  
 → an address. 

4 Select the Receiver box, enter an email address,  
and then select Done.

• To use an address from the list of previous recipients, select  
 → an address.

• Select  to add additional recipients. You can input up to  
30 recipients.

• Select  to delete an address from the list.

5 Select Next.

6 Scroll to files to send, and then press [o].

• You can select up to 20 files. The total size must be 10 MB or 
less.

7 Select Send.

8 Select the Comment box, enter your comments, and then 
select Done.

9 Select Send.

• The camera will automatically attempt to connect to a WLAN via 
the most recently connected AP device and send the email.

• If the camera has not previously been connected to a WLAN,  
it will search for available AP devices. (p. 101)
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• You cannot send RAW files.
• You can send up to 20 files at a time.
• Even if a photo appears to have transferred successfully, errors with the 

recipient’s email account may cause the photo to be rejected or recognized 
as spam. 

• You may not be able to send an email if no network connection is available 
or if your email account settings are incorrect.

• The maximum photo resolution you can send is 2M and the longest video 
you can send is a video recorded using . If the selected photo resolution 
is higher than 2M, it will be automatically resized to a lower resolution.

• If you cannot send an email because of firewall or user authentication 
settings, contact your network administrator or network service provider.

• When there are no files in the camera memory, you cannot use this feature.
• You can also send an email in Playback mode by pressing [m], and 

then selecting z → Share(Wi-Fi) → Email.
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You can upload your photos to SkyDrive. To upload files, you must visit 
the Microsoft website and register before connecting your camera.

1 Rotate the mode dial to B.

2 Select .

• If the pop-up message that prompts you to create an account 
appears, select OK.

• The camera will attempt to connect to a WLAN via the most 
recently connected AP.

• If the camera has not previously been connected to a WLAN,  
it will search for available AP devices. (p. 101)

3 Log in with your ID and password.

• For information about entering text, refer to "Entering text".  
(p. 105)

• If you connected to SkyDrive, refer to "Using the login browser". 
(p. 103)

• Press [m] to use option menus.

Option Description

Previous Page Move to the previous page.

Next Page Move to the next page.

Reload Reload the page.

Stop Stop loading the page.

Exit Close the login browser.

4 Scroll to the photos you want to upload, and then  
press [o].

5 Select Upload.

• You can also upload photos to a cloud server in Playback mode by 
pressing [m], and then selecting z → Share(Wi-Fi) →  
a cloud server.

• When there are no photos in the camera memory, you cannot use this 
feature.

Uploading photos to a cloud server
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You can send photos or videos that you captured with the camera to a 
PC wirelessly. The Auto Backup feature works only with the Windows 
OS.

Installing the program for Auto Backup 
on your PC

1 Install Intelli-studio on the PC. (p. 141)

2 Connect the camera to the PC with the USB cable.

3 Click OK on the pop-up window.

• The Auto Backup program is installed on the PC. Follow the  
on-screen instructions to complete the installation.

4 Remove the USB cable.

5 Connect the camera to the PC again with the USB cable.

• The camera stores information about the PC, so that the camera 
can send files to the PC.

Before installing program, ensure that the PC is connected to a network.  
If no internet connection is available, you must install the program from the 
provided CD.

Sending photos or videos to a PC

1 Rotate the mode dial to B.

2 Select .

• You must configure the backup PC information to use the Auto 
Backup feature. For more details, refer to “Installing the program 
for Auto Backup on your PC”. (p. 116)

3 Press [m] to set options.

• To turn off your PC automatically after the transfer is complete, 
select  → Shut down PC after backup → On.

• To view the help for the Auto Backup function, select  → 
Guide.

4 Press [o] to start the backup.

• To cancel sending, press [o].

• You cannot select individual files to backup. This function backs 
up only new files on the camera.

• The backup's progress will be shown on the PC monitor.

• When the transfer is completed, the camera will turn off 
automatically in approximately 30 seconds. Select Cancel to 
return to the previous screen and prevent the camera from 
turning off automatically.

Using Auto Backup to send photos or videos
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• If the PC supports the Wake on LAN (WOL) feature, you can turn on the 
PC automatically by searching for the PC from your camera. (p. 121)

• When you connect the camera to the WLAN, select the AP that is 
connected to the PC.

• The camera will search for available access points even if you are 
connecting to the same access point again.

• If you turn off the camera or remove the battery while sending files, the file 
transfer will be interrupted.

• While you are using this feature, only [Power] is available on your camera.
• You can connect only one camera to the PC at a time for sending files.
• The backup may be canceled due to network conditions.
• Photos or videos can be sent to a PC one time only. Files cannot be sent 

again even if you reconnect your camera to another PC.
• When there are no files in the camera memory, you cannot use this feature.
• You must turn off Windows Firewall and any other firewalls before using this 

feature.
• You can send up to 1,000 files.
• On the PC software, the server name must be entered in the Latin alphabet 

and can contain no more than 48 characters.
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TV Link is a technology for sharing media files between a camera and 
TV connected to the same AP device. With this technology, you can 
view your photos or videos on a widescreen TV.

1 Rotate the mode dial to B.

2 Select .

• If the guide message appears, press [o].

• The camera will automatically attempt to connect to a WLAN via 
the most recently connected AP device.

• If the camera has not previously been connected to a WLAN,  
it will search for available AP devices. (p. 101)

3 Connect your TV to a wireless network via an AP device.

• Refer to your TV’s user manual for more information.

4 On the TV, search for the camera and browse the shared 
photos or videos.

• For information about searching for the camera and browsing the 
photos or videos on the TV, refer to the TV's user manual.

• Videos may not play smoothly depending on the type of TV or 
network condition. If this happens, re-record the video in  or 

 quality and play it again. If videos do not play smoothly on 
your TV over the wireless connection, try connecting the camera 
to the TV with the HDMI cable.

AP

Viewing photos or videos on a TV Link-enabled TV
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• You cannot share RAW files.
• You can share up to 1,000 photos or videos.
• On a TV screen, you can view only photos or videos captured with your 

camera.
• The range of the wireless connection between your camera and a TV may 

vary depending on the specifications of the AP.
• If the camera is connected to 2 TVs, playback may be slower.
• You can use this feature only with TV Link-enabled TVs.
• Photos or videos will be shared in their original sizes.
• Some videos may buffer more slowly than others.
• Shared photos or videos will not be stored on the TV, but they can be 

stored in the camera to meet the TV's specifications. 
• Transferring photos or videos to the TV may take some time depending on 

the network connection, the number of files to be shared, or sizes of the 
files.

• If you power off the camera abnormally while viewing photos or videos on 
a TV (for example, by removing the battery), the TV considers the camera 
to still be connected.

• The order of photos or videos on the camera may be different than on the 
TV.

• Depending on the number of photos or videos you want to share, it may 
take some time to load your photos or videos and complete the initial  
set-up process.

• While viewing photos or videos on the TV, continuously using the TV 
remote or performing additional operations on the TV may prevent this 
feature from working properly.

• If you reorder or sort files on the camera while viewing them on a TV, you 
must repeat the initial set-up process to update the list of files on the TV.

• When there are no files in the camera memory, you cannot use this feature.
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When the camera connects via a WLAN to a device that supports the 
Wi-Fi Direct function, you can send photos to the device. This feature 
may not be supported on some devices.

1 On the device, turn on the Wi-Fi Direct option.

2 On the camera, in Playback mode, scroll to a photo.

3 Press [m], and then select z → Share(Wi-Fi) → 
Wi-Fi Direct.

• When in the single image view, you can send only one photo at a 
time.

• When in the thumbnails view, you can select multiple photos by 
scrolling to thumbnails, and then pressing [o]. Select Send when 
you are finished selecting photos.

4 Select the device from the camera's list of Wi-Fi Direct 
devices.

• Ensure that the device's Wi-Fi Direct option is turned on. 

• You can also select your camera from the device's list of Wi-Fi 
Direct devices.

5 On the device, allow the camera to connect to the device.

• The photo will be sent to the device.

• You can send up to 20 files at a time.
• When there are no photos in the camera memory, you cannot use this 

feature.
• If you cancel the connection attempt before it is complete, the camera may 

not be able to reconnect to the device. In this case, update your device 
with the latest firmware.

Sending photos using Wi-Fi Direct
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With the WOL feature, you can automatically turn on or wake up a PC with your camera. This feature has been available for Samsung desktop PCs for 
the last 5 years (not available for all-in-one PCs).

Any changes to your PC’s BIOS settings other than the ones described below may damage your PC. The manufacturer is not responsible for damage caused by  
your changing your PC’s BIOS settings.

Setting the PC to wake up from sleep mode

1 Click Start, and then open the Control Panel.

2 Configure the network connection.

• Windows 7:  
Click Network and Internet → Network and Sharing  
Center → Change adapter settings.

• Windows Vista: 
Click Network and Internet → Network and Sharing 
Center → Manage network connections.

• Windows XP: 
Click Network and Internet Connection →  
Network Connection.

3 Right click Local Area, and then click Properties.

4 Click Configure → the Power manage tab → Allow this 
device to wake the computer.

5 Click OK.

6 Restart the PC.

About the Wake on LAN (WOL) feature
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Setting the PC to turn on

1 Turn on the PC, and then press F2 while the PC is 
booting.

• The BIOS setting menu will appear.

2 Select Advanced tab → Power management Setup.

3 Select Resume on PME → Enabled.

4 Press F10 to save your changes, and then continue 
booting.

5 Click Start, and then open the Control Panel.

6 Configure the network connection.

• Windows 7:  
Click Network and Internet → Network and Sharing  
Center → Change adapter settings.

• Windows Vista: 
Click Network and Internet → Network and Sharing  
Center → Manage network connections.

• Windows XP: 
Click Network and Internet Connection →  
Network Connection.

7 Select drivers related to network adapter.

8 Click Advanced tab, and then set WOL menus.

• You cannot use this feature across a firewall or if a security program has 
been installed.

• To turn on the PC with the WOL feature, the PC must have an active 
connection to the LAN. Ensure that the indicator light on the PC’s LAN 
port is on indicating that the LAN connection is active.

• Depending on your PC model, the camera may only be able to wake the 
PC.

• Depending on your PC’s OS or drivers, the names of the WOL setting 
menu may vary.
 - examples of setting menu names: Enable PME, Wake on LAN, etc.
 - examples of setting menu values: Enable, Magic packet, etc.



Chapter 5
Camera settings menu

Learn about the user settings and general settings menu.  
You can adjust the settings to better suit your needs and preferences.
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You can set the user environment with these settings.

To set user 
options,  In Shooting mode, press [m] → u or X  

→ an option.

Available items and the order of them may differ depending on the shooting 
mode.

ISO Customizing

ISO Step

You can set the size for the ISO sensitivity by either 1/3 or 1 step.

Auto ISO Range

You can set the maximum ISO value under which each EV step is 
chosen when you set the ISO Auto.

* Default

Option Value

1 Step ISO 200, ISO 400, ISO 800*, ISO 1600, ISO 3200

1/3 Step
ISO 125, ISO 160, ISO 200, ISO 250, ISO 320,  
ISO 400, ISO 500, ISO 640, ISO 800*, ISO 1000,  
ISO 1250, ISO 1600, ISO 2000, ISO 2500, ISO 3200

Noise Reduction
Use the Noise Reduction to reduce the visual noise in photos.

* Default

Option Description

High ISO NR This function reduces noise that may occur when you 
set a high ISO sensitivity. (Off, On*)

Long Term NR This function reduces noise when you set the camera 
for a long exposure. (Off, On*)

DMF (Direct Manual Focus)
You can adjust the focus manually by rotating the focus ring after 
achieving the focus by half-pressing [Shutter]. This feature may not be 
available with some lenses.

User settings
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AF Priority
You can set the camera to capture photos only when the subject is in 
focus.

When you capture continuous or burst shots, the camera will capture photos 
even if the AF priority function is turned on and the subject is not in focus.

Distortion Correct
You can correct lens distortion that might occur from lenses.  
This feature may not be available with some lenses.

iFn Customizing
You can select options that can be adjusted when you press  
[i-Function] on an i-Function lens.

Option Description

Aperture Set to adjust the aperture value.

Shutter Speed Set to adjust the shutter speed.

EV Set to adjust the exposure value.

ISO Set to adjust ISO sensitivity.

WB Set to adjust the white balance.

Z Set to adjust the zoom ratio.
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User Display
You can add or remove shooting information from the display.

12

3

5 4

No. Description

1 Right Icons
Set to display icons on the right in Shooting mode.

2 Left Icons
Set to display icons on the left in Shooting mode.

3 Date & Time
Set to display the date and time.

No. Description

4 

Histogram
Set the histogram on the display on or off. 

About histogram
A histogram is a graph that shows the brightness distribution of a 
photo. A histogram inclined to the left indicates a dark photo.  
A histogram inclined to the right indicates a bright photo. The height 
of the graph is related to color information. The graph gets higher if a 
specific color is more common.

Insufficient exposure Balanced exposure Excessive exposure

5 

Distance Scale
Set to display the distance between a subject and the camera when 
you attach a lens that supports the Distance Scale function.  
(Off, ft, m*)

This feature is available only when you attach a lens that supports 
the Distance Scale function.



127

Camera settings menu > User settings

Key Mapping
You can change the function assigned to the Custom button or Wi-Fi 
shortcut button.

* Default

Button Function

Custom

Set a function of the Custom button.
• Optical Preview*, which executes the Depth of 

Field Preview function for the current aperture 
value. (p. 22)

• One Touch WB (White Balance), which executes 
the Custom White Balance function.

• One Touch RAW +, which activates or deactivates 
the RAW+JPEG feature.

• Reset, which resets some settings.
• AEL, which executes the auto exposure lock 

function.

Wi-Fi
Set a function of the Wi-Fi shortcut button. 
(MobileLink*, Remote Viewfinder, Social Sharing, 
Email, SkyDrive, Auto Backup, TV Link)

Grid Line
Select a guide to help you compose a scene. (Off*, 3 X 3, 4 X 4, +, X)

AF Lamp
When shooting in dark places, turn the AF lamp on in order to have a 
better auto focus. The Auto Focus functions more accurately in dark 
places when the AF lamp is on.
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Learn about the menu items of the Setting 1.

To set Setting 1 
options,  In Shooting or Playback mode, press [m] → q  

→ an option.

* Default

Item Description

Language Set a language the camera shows on the display.

File Name

Set the method of creating file names.
• Standard*: SAM_XXXX.JPG (sRGB)/ 

_SAMXXXX.JPG (Adobe RGB)
• Date: 

 - sRGB files - MMDDxxxx.JPG. For example, for a photo 
captured on Jan. 01, the file name would be  
0101xxxx.jpg.

 - Adobe RGB files - MDDxxxx.JPG for the months Jan 
through Sept. For the months Oct through Dec, the 
month number is replaced by the letters A (Oct.),  
B (Nov.) and C (Dec.). 
For example, for a photo captured on Feb. 03, the file 
name would be 203xxxx.jpg. For a photo captured on 
Oct. 05, the file name would be A05xxxx.jpg.

* Default

Item Description

File Number

Set the method of numbering files and folders.
• Reset: After using the reset function, the next file name 

is started at 0001.
• Series*: New file numbers continue the existing number 

sequence, even if you have installed a new memory 
card, formatted the card, or deleted all photos.

• The first folder name is 100PHOTO, if you have 
selected the sRGB color space and Standard file 
naming, the first file name is SAM_0001.

• File name numbers are increased by 1 from 
SAM_0001 to SAM_9999.

• Folder numbers are increased by 1 from 100PHOTO 
to 999PHOTO.

• The maximum number of files that can be saved in 
one folder is 9,999.

• File numbers are assigned according to DCF (Design 
rule for Camera File system) specifications.

• If you change a file name (for example, on a 
computer), the camera will not be able to play the file.

Setting 1
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* Default

Item Description

Folder Type
Set the type of folder.
• Standard*: XXXPHOTO
• Date: XXX_MMDD

Format

Format the memory card. Formatting prepares a memory 
card for use in the camera and deletes all existing files 
including protected files. (Yes, No)

Errors can occur if you use a memory card formatted 
by another brand of camera, a memory card reader, or 
a computer. Please format memory cards in the camera 
before using them to capture photos.

Reset
Reset the setup menu and shooting options to the factory 
defaults. (Date, time, language, and video output settings 
do not change.) (Yes, No)
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Learn about the menu items of the Setting 2.

To set Setting 2 
options,  In Shooting or Playback mode, press [m] → w  

→ an option.

* Default

Item Description

Quick View
Set the Quick View time length – the amount of time the 
camera displays a photo immediately after you captured it. 
(Off, 1 sec*, 3 sec, 5 sec, Hold)

Display 
Adjust

Adjust the display brightness, auto brightness setting, or 
display color.
• Display Brightness: You can adjust the display 

brightness manually.
• Auto Brightness: Turn auto brightness on or off.  

(Off, On*)
• Display Color: You can adjust the display color 

manually.

Auto Display 
Off 

Set the display off time. The display turns off if you do not 
use the camera for the time you set.  
(Off, 30 sec*, 1 min, 3 min, 5 min, 10 min)

* Default

Item Description

Power Save

Set power shut off time. The camera shuts off if you do 
not use it for the time you set. (30 sec, 1 min*, 3 min,  
5 min, 10 min, 30 min)

• The camera retains the power-off time setting even if 
you replace the battery.

• Power save may not work if the camera is connected 
to a computer, TV, or printer, playing a slide show or 
movie.

Date & Time

Set date, time, date format, time zone and whether to 
imprint the date on photos. (Time Zone, Date, Time, 
Type, Imprint)

• The date appears on the lower right side of the photo.
• When you print a photo, some printers may not print 

the date appropriately. 

Help Guide 
Display

Set to display help text about menus and functions.  
(Off, On*)

Press [ ] to hide the help text.

Setting 2
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Learn about the menu items of the Setting 3.

To set Setting 3 
options,  In Shooting or Playback mode, press [m] → e  

→ an option.

* Default 

Item Description

Sound

• System Volume: Set the sound volume or turn all sound 
off entirely. (Off, Low, Medium*, High)

• AF Sound: Set the sound the camera makes in AF mode 
on or off. (Off, On*)

• Button Sound: Set the sound the camera makes when 
you press buttons on or off. (Off, On*)

Sensor 
Cleaning

• Sensor Cleaning: Remove dust from the sensor.
• Start-Up Action: When on, the camera performs sensor 

cleaning each time you turn it on. (Off*, On)

As this product uses interchangeable lenses, the sensor 
can get dust on it when you change lenses. This can lead 
to dust particles appearing in the photos you capture. It 
is recommended not to change lenses when you are in a 
particularly dusty area. Also, make sure to attach the lens 
cap to the lens when not using it.

Video Out

Set the video signal output appropriate for your country 
when connecting the camera to an external video device 
such as a monitor or TV.
• NTSC*: USA, Canada, Japan, Korea, Taiwan, Mexico, etc
• PAL (Supports only PAL B, D, G, H, or I): Australia, 

Austria, Belgium, China, Denmark, Finland, France, 
Germany, England, Italy, Kuwait, Malaysia, New Zealand, 
Singapore, Spain, Sweden, Switzerland, Thailand, 
Norway, etc

* Default 

Item Description

Anynet+ 
(HDMI-CEC)

When you connect the camera to an HDTV that supports 
Anynet+ (HDMI-CEC), you can control the play function of 
the camera with the TV remote control.
• Off: You cannot control the play function of camera with 

the TV remote control.
• On*: You can control the play function of camera with the 

TV remote control.

HDMI 
Output

When you connect the camera to an HDTV with an HDMI 
cable, you can change the resolution of the image.
• NTSC: Auto*, 1080i, 720p, 576p (activates only when 

PAL is selected), 480p

If the connected HDTV does not support the resolution you 
select, the camera sets the resolution one level lower.

Device 
Information

View the firmware version of the body and the lens, Wi-Fi 
MAC address, and network certification number, or update 
the firmware.
• Firmware Update: Update the firmware of the camera 

body or lens. (Body Firmware, Lens Firmware)

• You can download firmware upgrades from  
www.samsung.com.

• You cannot run a firmware upgrade without a fully 
charged the battery. Recharge the battery fully before 
running a firmware upgrade.

• If you update the firmware, user settings values will be 
reset. (Date, time, language, video out will not change.)

• Do not turn the camera off while the update is in progress.

Setting 3

www.samsung.com
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Learn about the menu items of the GPS setting. You should purchase 
an optional GPS accessory in order to use the GPS function.

To set GPS 
options,  In Shooting or Playback mode, press [m] → U  

→ an option.

* Default

Item Description

Geotagging

Set to capture photos with location information 
using the Global Positioning System (GPS). Location 
information is added to the Exif data associated with 
the photo. (Off, On*)

GPS Valid Time 
Settings

Set the time to use the last location information when 
the camera fails to receive GPS signals. If the camera 
fails to receive GPS signals after the specified time, 
the location information will not be recorded onto the 
photos. (15 sec*, 30 sec, 1 min, 3 min, 10 min,  
30 min)

Location 
Display

Set to display the location information on the top right 
screen of Shooting mode. The location information 
will appear in Korean only when you are in Korea and 
the display language is set to Korean. When another 
language is set, the location information will appear in 
English. (Off, On*)

GPS Reset Set to search for GPS satellites closest to your current 
position. (Yes, No)

 

GPS



Chapter 6
Connecting to external devices

Make full use of the camera by connecting it to external devices such as a computer, HDTV or photo printer. 
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Play back photos or videos by connecting your camera to an HDTV  
(3D TV) using an optional HDMI cable.

Viewing files on an HDTV

1 In Shooting or Playback mode, press [m] → e → 
HDMI Output → an option.

2 Turn off your camera and HDTV.

3 Connect the HDTV and the camera using the optional 
HDMI cable.

4 Make sure that the HDTV and camera are turned on, and 
then select the HDMI mode on the HDTV.

• The HDTV screen mirrors the camera's display.

5 View the videos and photos using the buttons on the 
camera.

• When using the HDMI cable, you can connect the camera to an HDTV 
using the Anynet+(CEC) method. 

• The Anynet+(CEC) functions allow you to control connected devices using 
the TV remote control.

• If the HDTV supports Anynet+(CEC), the TV turns on automatically when 
used in conjunction with the camera. This feature may not be available on 
some HDTVs.

• When connected to an HDTV by an HDMI cable, the camera cannot 
capture a photo or video.

• When connected to an HDTV, some of the camera’s playback functions 
may not be available.

• The length of time after which the camera and an HDTV are connected 
may vary depending on the memory card that you are using.

• As the main feature of a memory card is to increase the transfer speed, it is 
not necessarily true to say that a memory card with a faster transfer speed 
is also fast in using the HDMI function.

Viewing files on an HDTV or a 3D TV
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Viewing files on a 3D TV
You can view photos captured in 3D mode or 3D Panorama mode on a 
3D TV.

1 In Shooting or Playback mode, press [m] → e →  
HDMI Output → an option.

2 Turn off your camera and 3D TV.

3 Connect your camera to your 3D TV with the optional 
HDMI cable.

4 Turn on your camera.

• If you have an Anynet+ compatible Samsung 3D TV and you 
have turned on your camera's Anynet+ function, the 3D TV 
turns on automatically and displays the camera screen, while the 
camera automatically enters Playback mode.

• If you turn Anynet+ off in your camera, the 3D TV does not turn 
on automatically.

5 Press [I] on the camera or the mode switching button 
on the TV to switch to 3D Mode.

• Press [I] or the mode switching button again to switch to  
2D Mode.

6 Turn on your TV's 3D function.

• Refer to your TV's user manual for more details.

7 View 3D photos with the buttons on your TV's remote 
control.

• You cannot view an MPO file in 3D effect on TVs that do not support 
the file format.

• Use proper 3D glasses when you view an MPO file on a 3D TV.

Do not view the 3D images captured by your camera on a 3D TV or 
3D monitor for an extended period of time. It may cause unpleasant 
symptoms, such as eyestrain, fatigue, nausea, and more.
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Print photos on your camera by connecting to printers directly or saving 
Digital Print Order Format (DPOF) information on a memory card.

Printing photos with a PictBridge photo 
printer
You can print photos with a PictBridge-compatible printer by connecting 
your camera directly to the printer.

1 With the printer on, connect your camera to the printer 
with the USB cable.

2 Turn on your camera.

• When the pop-up message appears on the camera display, 
select Printer.

3 Press [C/F] to select a photo.

• Press [m] to set printing options.

4 Press [o] to print.

Printing photos
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Configuring print settings

Images

Size

Layout

Type

Quality

Date

Exit Print

One Photo

Option Description

Images Select whether to print the current photo or all photos.

Size Specify the size of the print.

Layout Set the number of photos per page.

Type Select the type of paper.

Quality Set the print quality.

Date Set to print the date.

File Name Set to print the file name.

Reset Reset setting to their default values.

Some options may not be supported by some printers.

Creating a print order (DPOF)
DPOF (Digital Print Order Format) lets you set the print size of a photo 
and the number of copies to be printed. The camera saves the DPOF 
information in the MISC folder of your memory card. Your camera 
displays a DPOF indicator when it displays an image with DPOF 
information. If you have set DPOF information for your images, you can 
take the memory card to a digital printing shop for printing.

To set DPOF 
options,  In Playback mode, press [m] → x → DPOF →  

an item.
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DPOF options

Option Description

Standard

You can select photos to print and the number of copies 
for photos.
• Select: Select the number of copies for photos you 

select. (Scroll to the photos you want to print → Select 
the number of copies by rotating the navigation button, 
and then pressing [f].)

• All: Select the number of copies for all photos. (Select 
the number of copies by pressing [D/I], and 
then pressing [o].)

• Reset: Cancel all DPOF printing quantity selections. 

Index
This option lets you print all photos set to be printed as 
thumbnails in a single paper. The print size that you have 
set is available only with DPOF 1.1-compatible printers.

Size

You can specify the size of the print.
• Select: Select the print size for photos you choose. 

(Scroll to the photos you want to print → Select the 
print size by rotating the navigation button, and then 
pressing [f].)

• All: Select the print size of all the photos saved in 
the memory card. (Select the print size by pressing 
[D/I], and then pressing [o].)

• Reset: Cancel the DPOF print size for all photos.
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Transfer files on a memory card to your computer by connecting the 
camera to the PC.

Transferring files to your Windows 
computer

Connecting the camera as a removable disk

You can connect the camera to your computer as a removable disk.

1 Turn off the camera.

2 Connect the camera to your computer with the USB 
cable.

• You must plug the small end of the USB cable into your camera. If the 
cable is reversed, it may damage your files. The manufacturer is not 
responsible for any loss of data.

• If you try to plug the USB cable into the HDMI port, the camera may 
not work properly. If it occurs, restart the camera.

3 Turn on the camera.

• When the pop-up message appears on the camera display, 
select Computer.

4 On your computer, select My Computer → Removable 
Disk → DCIM → XXXPHOTO or XXX_MMDD.

5 Select the files you want, and then drag or save them to 
your computer.

If the Folder Type is set to Date, the folder name appears as “XXX_MMDD”. 
For example, if you capture a photo on January 1, the folder name will be 
"101_0101".

Transferring files to your computer
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Disconnecting the camera (for Windows XP)

With Windows Vista and Windows 7, the methods for disconnecting the 
camera are similar.

1 Ensure that no data is being transferred between the 
camera and the computer.

• If the status lamp on your camera is blinking, it means the data 
transfer is in progress. Please wait until the status lamp stops 
blinking.

2 Click  on the tool bar at the bottom right of your 
computer screen.

3 Click the pop-up message.

4 Click the message box indicating safely removed.

5 Remove the USB cable.

Transferring files to your Mac computer

1 Turn off the camera.

2 Connect your camera to a Macintosh computer with the 
USB cable.

Mac OS 10.4 or later is supported.

• You must plug the small end of the USB cable into your camera. If the 
cable is reversed, it may damage your files. The manufacturer is not 
responsible for any loss of data.

• If you try to plug the USB cable into the HDMI port, the camera may 
not work properly. If it occurs, restart the camera.

3 Turn on the camera.

• When the pop-up message appears on the camera display, 
select Computer.

4 Open the removable disk.

5 Transfer photos or videos to the computer.
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Digital photos can be edited in a variety of ways through image editing 
programs. Learn to edit photos using the provided editing programs.

Installing software

1 Insert the CD-ROM into your PC.

2 When the setting wizard appears, click Samsung Digital 
Camera Installer.

3 Select a program you want to install, and then click 
Install.

4 Follow the on-screen instructions.

5 When the installation is complete, click Exit.

Programs contained on the CD

Program Purpose

Intelli-studio Edit photos and videos.

Samsung RAW Converter Convert RAW files into the desired file 
format.

PC Auto Backup Send the recorded files to a connected PC 
via Wi-Fi.

• If your computer does not meet the requirements, videos may not play 
correctly or it may take longer to edit videos.

• Install DirectX 9.0c or above before you use the program.
• You must use Windows XP/Vista/7 or Mac OS 10.4 or later to connect the 

camera as a removable disk.

Using a self-assembled PC or a PC and OS that are not supported may void 
your warranty.

Using programs on a PC
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Using Intelli-studio
Intelli-studio is a built-in program that allows you to play back and edit 
files. You can also upload files to your favorite websites. For details, 
select Help → Help in the program.

Requirements

Item Requirements

OS* Windows XP SP2, Windows Vista, or Windows 7 
(32-bit editions)

CPU Intel® Core 2 Duo 1.66 GHz or higher/ 
AMD Athlon™ X2 Dual-Core 2.2 GHz or higher

RAM Minimum 512 MB RAM  
(1 GB or more recommended)

Hard disk capacity 250 MB or more (1 GB and above recommended)

Others

• CD-ROM drive
• 1024x768 pixels, 16-bit color display compatible 

monitor (1280x1024 pixels, 32-bit color display 
recommended)

• USB 2.0 port
• nVIDIA Geforce 7600GT or higher/ 

ATI X1600 series or higher
• Microsoft DirectX 9.0c or later

*  A 32-bit version of Intelli-studio will be installed—even on 64-bit editions of Windows XP, 
Windows Vista and Windows 7.

• The requirements are recommendation only. It may not work properly even 
when the computer meets the requirements, depending on the condition of 
your computer.

• Intelli-studio is compatible only with Windows.
• Intelli-studio supports the following formats:

 - Videos: MP4 (Video: H.264, Audio: AAC), WMV (WMV 7/8/9),  
AVI (MJPEG)

 - Photos: JPG, GIF, BMP, PNG, TIFF
• You cannot open the RAW format files with the Intelli-studio program.
• You cannot edit files directly on the camera. Transfer files to a folder on 

your computer before editing.
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Using the Intelli-studio Interface

1 2 3 4 5 6 7

8

9

1012

13

14
15

11

No. Description

1 Open menus.

2 Display files in the selected folder.

3 Change to the Photo edit mode.

4 Change to the Video edit mode.

5 Change to the Sharing mode. (You can send files by email or 
upload files to websites, such as Flickr or YouTube.)

6 Enlarge or reduce the thumbnails in the list.

7 Select a file type.

No. Description

8 View files of the selected folder on your computer.

9 Show or hide files of the connected camera.

10 View files of the selected folder on the camera.

11 View files as thumbnails or on a map.

12 Browse folders in the connected device.

13 Browse folders in your computer.

14 Move to the previous or next folder.

15 Print files, view files on a map, store files in My Folder, or register 
faces.
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Transferring files using Intelli-studio

You can easily transfer files on your camera to your computer by using 
Intelli-studio.

1 Turn off the camera.

2 Connect the camera to your computer with the USB 
cable.

• You must plug the end of the cable with the correct connection plug 
into your camera. If the cable is reversed, it may damage your files. 
The manufacturer is not responsible for any loss of data.

• If you try to plug the USB cable into the HDMI port, the camera may 
not work properly. If it occurs, restart the camera.

3 Run Intelli-studio on your computer.

4 Turn on the camera.

• When the pop-up message appears on the camera display, 
select Computer.

5 Select a folder on your computer to save new files and 
select Yes.

• New files will be transferred to the computer.

• If your camera has no new files, the pop-up window for saving 
new files will not appear.
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Using Samsung RAW Converter
Photos captured by a camera are often transformed to JPEG formats 
and stored in the memory according to the settings of the camera at 
the time of shooting. RAW files are not transformed to JPEG formats 
and are stored in the memory without any changes. With Samsung 
RAW Converter, you can calibrate exposures, White Balances, tones, 
contrasts, and colors of photos.

Requirements for Windows

Item Requirements

OS
Microsoft Windows XP, Windows Vista, or Windows 7
* Administrator rights are needed for installation.
* The program runs as a 32-bit application under the 64-bit OS.

CPU

Intel Pentium®, AMD Athlon™ processor-based  
PC or compatible computer (Pentium4, Athlon XP, or 
later recommended)
* Multi-core processor ready (Intel Core i7, Core 2 Quad,  

Core 2 Duo, AMD phenom IIX4, Phenom X4, etc.)

RAM 1 GB or more recommended

Hard disk capacity
Please reserve at least 100 MB of space. Please 
allocate sufficient disk space for image storage.  
(One image may use more than 10 MB of disk space.)

Others
• XGA (1024x768), Full Color (24 bit or higher)
• Keyboard, mouse, or equivalent devices

Requirements for Mac

Item Requirements

OS Apple® Mac® OS X v10.4/v10.5/v10.6

CPU Intel processor-based or compatible computer 
(Core 2 Quad or later recommended) / PowerPC

RAM 1 GB or more recommended

Hard disk capacity

Please reserve at least 100 MB of space. Please 
allocate sufficient disk space for image storage. 
(One image may use more than 10 MB of disk 
space.)

Others
• XGA (1024x768), Full Color (24 bit or higher)
• Keyboard, mouse, or equivalent devices

• Samsung RAW Converter may not perform correctly on some computers, 
even when the computer meets the requirements.

• The Mac installation program will not autorun. Please manually run the 
setup file on the provided CD-ROM.
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Using the Samsung RAW Converter Interface

For details about using Samsung RAW Converter, click Help →  
Open software manual.

1
2

3

4

No. Description

1 Menu

2 Toolbar

3 Editing tools

4 Open/Close the fine adjustment window for the editing tools.

Editing RAW format files

If you edit the RAW format files with the Samsung RAW Converter, 
you can maintain high image quality. You can also edit JPEG and TIFF 
format files.

To adjust the exposure of an image

1 Select File → Open file and open a file.

2 From the editing tools, select W.
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3 Adjust the exposure with the scroll bar.

Original image
P Mode, Aperture: f=8,  

Shutter Speed: 1/15 sec, ISO=100

Edited image

Original image Edited image

To adjust the contrast of an image

1 Select File → Open file and open a file.

2 From the editing tools, select .

3 Adjust the tone with the scroll bar.

Original image Edited image

To save RAW files in JPEG or TIFF formats

1 Select File → Open file and open a file.

2 Select File → Development.

3 Select a file format (JPEG or TIFF) and select Save.



Chapter 7
Appendix

Get information about error messages, camera maintenance,  
trouble shooting tips, specifications, and optional accessories. 
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When the following error messages appear, try these remedies.

Error messages Suggested remedies

Lens is locked The lens is locked. Rotate the lens counter-
clockwise until you hear a click. (p. 36)

Card Error
• Turn off your camera, and then turn it on again.
• Remove your memory card and insert it again.
• Format your memory card.

Low Battery Insert a charged battery or recharge the battery.

No Image File Capture photos or insert a memory card that 
contains photos.

File Error Delete the damaged file or contact a service center.

Memory Full Delete unnecessary files or insert a new memory 
card.

Card Locked
You can lock SD, SDHC or SDXC card to prevent 
files from being deleted. Unlock the card when 
shooting. (p. 153)

Error messages Suggested remedies

Folder and file 
number are max 
values. Replace 
the card

File names do not match the DCF standard. 
Transfer the files on the memory card to your 
computer and format the card. (p. 129)

Error 00 Turn off your camera and remount the lens. If the 
message still appears, contact a service center.

Error 01/02
Turn off your camera, remove the battery, and insert 
again. If the message still appears, contact a service 
center.

Error messages
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Cleaning the camera

Camera lens and display

Use a brush to remove dust and wipe the lens gently with a soft cloth.  
If any dust remains, apply lens cleaning liquid to a piece of cleaning 
paper and wipe gently.

Image sensor

Depending on different shooting conditions, dust may appear in photos 
because the image sensor is exposed to the external environment. 
This problem is normal, and the exposure to dust occurs in everyday 
use of the camera. You can remove dust from the sensor by operating 
the sensor cleaning function. (p. 131) If dust remains after cleaning 
the sensor, contact a service center. Do not insert the blower into the 
mounting opening of the lens.

Camera body

Wipe gently with a soft, dry cloth.

Never use benzene, thinners or alcohol to clean the device. These solutions 
can damage the camera or cause it to malfunction.

Maintaining the camera
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Using on beaches or shores

• Protect your camera from sand and dirt when you use it on beaches 
or in other similar areas.

• Your camera is not waterproof. Do not handle the battery, or memory 
card with wet hands. Operating the camera with wet hands may 
cause damage to your camera.

Storing for extended period of time

• When you store the camera for an extended period, place it in a 
sealed container with an absorbent material, such as silica gel.

• Remove the batteries from your camera when storing it for an 
extended period. Installed batteries may leak or corrode over time and 
cause serious damage to your camera.

• Over time, unused batteries will discharge and must be recharged 
before use.

Using or storing the camera

Inappropriate places to use or store the camera

• Avoid exposing the camera to very cold or very hot temperatures.

• Avoid using your camera in areas with extremely high humidity, or 
where the humidity changes drastically.

• Avoid exposing the camera to direct sunlight and storing it in hot, 
poorly-ventilated areas, such as in a car during summer time.

• Protect your camera and the display from impact, rough handling, and 
excessive vibration to avoid serious damage.

• Avoid using or storing your camera in dusty, dirty, humid, or poorly-
ventilated areas to prevent damage to moving parts and internal 
components.

• Do not use your camera near fuels, combustibles, or flammable 
chemicals. Do not store or carry flammable liquids, gases, or explosive 
materials in the same compartment as the camera or its accessories.

• Do not store the camera where there are mothballs.
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Using the camera with caution in humid environments

When you transfer the camera from a cold environment to a warm 
one, condensation can form on the lens or internal components of the 
camera. In this situation, turn off the camera and wait for at least 1 hour.  
If condensation forms on the memory card, remove the memory card 
from the camera and wait until all moisture has evaporated before 
reinserting it.

Other cautions

• Do not swing your camera by the strap. This may cause injury to 
yourself or others or damage to your camera.

• Do not paint your camera, as paint can clog moving parts and prevent 
proper operation.

• Turn off the camera when not using it.

• Your camera consists of delicate parts. Avoid impacts to the camera.

• Protect the display from external force by keeping it in the case when 
not in use. Protect the camera from scratches by keeping it away from 
sand, sharp implements, or loose change.

• Do not use the camera if the screen is cracked or broken. Broken 
glass or acrylic could cause injury to your hands and face. Take the 
camera to a Samsung service center to have it repaired.

• Never place cameras, batteries, chargers, or accessories near, on, 
or in heating devices, such as microwave ovens, stoves, or radiators. 
These devices may be deformed and can overheat and cause a fire or 
explosion.

• Do not expose the lens to direct sunlight, as this may discolor the 
image sensor or cause it to malfunction.

• Protect your lens from fingerprints and scratches. Clean your lens with 
a soft, clean, debris-free lens cloth.

• The camera may turn off if impacted from the outside. This is to 
protect the memory card. Turn on the camera to use it again.

• While you use the camera, it may heat up. This is normal and should 
not affect your camera’s lifespan or performance.

• When you use the camera in low temperatures, it may take some time 
to turn on, the color of the display may be changed temporarily, or 
after-images may appear. These conditions are not malfunctions and 
they will correct themselves when the camera is returned to normal 
temperatures.

• Paint or metal on the outside of the camera may cause allergies,  
itchy skin, eczema, or swelling for people with sensitive skin.  
If you experience any of these symptoms, stop using the camera 
immediately and consult a doctor.



153

Appendix > Maintaining the camera

About memory card

Supported memory card

This product supports SD (Secure Digital), SDHC (Secure Digital 
High Capacity), SDXC (Secure Digital eXtended Capacity), microSD, 
microSDHC, or microSDXC memory cards.

Terminal

Write-protect switch

Label (front)

You can prevent files from being deleted by using the write-protect 
switch on an SD, SDHC or SDXC card. Slide the switch down to lock 
or slide it up to unlock. Unlock the card when capturing photos and 
videos.

Memory card adapter

Memory card

To use micro memory cards with this product, a PC, or a memory card 
reader, insert the card into an adapter.

Memory card capacity

The memory capacity may differ depending on shooting scenes or 
shooting conditions. These capacities are based on a 2 GB SD card.

Size
Quality

HQ Normal

Videos*

 
1920X1080 

(30 FPS)
Approx. XX' XX" Approx. XX' XX"

 
1920X810  
(24 FPS)

Approx. XX' XX" Approx. XX' XX"

 
1280X720  
(30 FPS)

Approx. XX' XX" Approx. XX' XX"

 
640X480  
(30 FPS)

Approx. XX' XX" Approx. XX' XX"

 
For Sharing  

(30 FPS)
Approx. XX' XX" Approx. XX' XX"

*  The recordable time may vary if you use the zoom. Several videos were recorded in 
succession to determine the total recording time.
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Size
Quality

Super Fine Fine Normal RAW RAW + S.Fine RAW + Fine RAW + Normal

Photo

20.0M (5472X3648) XX XX XX XX XX XX XX

10.1M (3888X2592) XX XX XX - XX XX XX

5.9M (2976X1984) XX XX XX - XX XX XX

2.0M (1728X1152) XX XX XX - XX XX XX

Burst XX XX XX - - - -

16.9M (5472X3080) XX XX XX - XX XX XX

7.8M (3712X2088) XX XX XX - XX XX XX

4.9M (2944X1656) XX XX XX - XX XX XX

2.1M (1920X1080) XX XX XX - XX XX XX

13.3M (3648X3648) XX XX XX - XX XX XX

7.0M (2640X2640) XX XX XX - XX XX XX

4.0M (2000X2000) XX XX XX - XX XX XX

1.1M (1024X1024) XX XX XX - XX XX XX
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Cautions when using memory cards

• Avoid memory cards to very cold or very hot temperatures (below  
0 °C/32 °F or above 40 °C/104 °F). Extreme temperatures can cause 
memory cards to malfunction.

• Insert a memory card in the correct direction. Inserting a memory card 
in the wrong direction may damage your camera and memory card.

• Do not use memory cards that have been formatted by other cameras 
or by a computer. Reformat the memory card with your camera.

• Turn off the camera when you insert or remove the memory card.

• Do not remove the memory card or turn off your camera while the 
lamp is blinking, as this may damage your data.

• When the lifespan of a memory card has expired, you cannot store 
any more photos on the card. Use a new memory card.

• Do not bend, drop, or subject memory cards to heavy impact or 
pressure.

• Avoid using or storing memory cards near strong magnetic fields.

• Avoid using or keeping memory cards in areas with high temperature, 
high humidity, or corrosive substances.

• Prevent memory cards from making contact with liquids, dirt, or 
foreign substances. If dirty, wipe the memory card clean with a soft 
cloth before you insert the memory card in your camera.

• Do not allow liquids, dirt, or foreign substances to come in contact 
with memory cards or the memory card slot. Doing so may cause 
memory cards or the camera to malfunction.

• When you carry a memory card, use a case to protect the card from 
electrostatic discharges.

• Transfer important data to other media, such as a hard disk, CD, or 
DVD.

• When you use the camera for an extended period, the memory 
card may become warm. This is normal and does not indicate a 
malfunction.

• Use a memory card that meets the standard requirements.

The manufacturer is not responsible for any loss of data.
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• Do not rest the device on flammable surfaces, such as bedding, carpets, 
or electric blankets for a prolonged period.

• When the device is switched on, do not leave it in any confined space for a 
prolonged period.

• Do not allow battery terminals to come in contact with metallic objects, 
such as necklaces, coins, keys, or watches.

• Use only authentic, manufacturer-recommended, Lithium-ion replacement 
batteries.

• Do not disassemble the battery or puncture the battery with any sharp 
object.

• Avoid exposing the battery to high pressure or crushing forces.
• Avoid exposing the battery to major impacts, such as dropping it from high 

places.
• Do not expose the battery to temperatures of 60 °C (140 °F) or above.
• Do not allow the battery to come in contact with moisture or liquids.
• Battery shall not be exposed to excessive heat such as sunshine, fire or 

the like.

Disposal guidelines

• Dispose of the battery with care.
• Do not dispose of the battery in a fire.
• Disposal regulations may differ by country or region. Dispose of the battery 

in accordance with all local and federal regulations.

Guidelines for charging the battery

Charge the battery only by the method described in this user manual. The 
battery can ignite or explode if not charged properly.

About the battery
Use only Samsung-approved batteries.

Battery specifications

Item Description

Model BP1030

Type Lithium-ion battery

Cell capacity 1,030 mAh

Voltage 7.4 V

Charging time 
(when the camera is switched off)

Approx. 140 min

Personal injury or death can occur if the battery is handled carelessly or 
improperly. For your safety, follow these instructions for proper battery 
handling:

• The battery can ignite or explode if not handled properly. If you notice 
any deformities, cracks, or other abnormalities in the battery, immediately 
discontinue use of the battery and contact your manufacturer.

• Use only authentic, manufacturer-recommend battery chargers and charge 
the battery only by the method described in this user manual.

• Do not place the battery near heating devices or expose to excessively 
warm environments, such as the inside of an enclosed car in the 
summertime.

• Do not place the battery in a microwave oven.
• Avoid storing or using the battery in hot, humid places, such as spas or 

shower enclosures.
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Notes about using the battery

• In temperatures below 0 °C/32 °F, battery capacity and battery life 
may decrease.

• Battery capacity may decrease in low temperatures but will return to 
normal in milder temperatures.

• When you use the camera for an extended period, the area around 
the battery chamber may become warm. This does not affect the 
normal use of the camera.

Notes about charging the battery

• If the indicator light is off, make sure that the battery is inserted 
correctly.

• Do not pull on the power supply cord to disconnect the plug from the 
power outlet. This may cause a fire or electric shock.

• When the battery is completely discharged, charge it at least  
10 minutes before using it with your camera.

• If the indicator light blinks orange or does not illuminate, reconnect the 
cable, or remove the battery and insert it again.

• If you charge the battery when the cable is overheated or the 
temperature is too high, the indicator light may turn orange. Charging 
will start when the battery cools down.

• Do not bend or place heavy objects on the AC cable. Doing so may 
damage the cable.

Battery life

Shooting mode Average time / Number of photos

Photos Approx. 165 min/Approx. 330 photos

Videos Approx. 140 min (Record videos at 1920X1080 
resolution and 30 FPS.)

• The figures above are based on Samsung’s test standards. Your 
results may differ depending on your actual usage.

• Available shooting time differs depending on background, shooting 
interval, and use conditions.

• Several videos were recorded in succession to determine the total 
recording time.

Low battery message

When the battery has fully discharged, the battery icon will turn red and 
the "Low Battery" message will appear.
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Before contacting a service center

If you are having trouble with your device, try these troubleshooting 
solutions before contacting a service professional.

When you leave your camera at a service center, be sure to also leave the 
other components that may have contributed to the malfunction, such as the 
memory card and battery. 

Situation Suggested remedies

Cannot turn on the 
camera

• Ensure that the battery is inserted.
• Ensure that the battery is inserted correctly.
• Charge the battery.

The power turns off 
suddenly

• Charge the battery.
• Your camera may be in Power save mode or 

the display turns off automatically. (p. 130)
• The camera may be turned off automatically 

to prevent the memory card from being 
damaged due to excessive heat. Turn on your 
camera again.

The camera is losing 
battery power quickly

• The battery may lose power more quickly 
in low temperatures (below 0 °C/32 °F). 
Keep the battery warm by putting it into your 
pocket. 

• Using the flash or recording videos depletes 
the battery quickly. Recharge if needed.

• Batteries are consumable parts that must be 
replaced over time. Get a new battery if the 
battery life is diminishing quickly.

Situation Suggested remedies

Cannot capture 
photos

• There is no space on the memory card. 
Delete unnecessary files or insert a new card.

• When the AF Priority function is turned on, 
you cannot capture a photo unless the focus 
is set correctly. Set AF Priority to Off or focus 
on the subject correctly. (p. 125)

• Format the memory card.
• The memory card is defective. Get a new 

memory card.
• The memory card is locked. Unlock the card. 

(p. 153)
• Ensure that the camera is switched on.
• Charge the battery.
• Ensure that the battery is inserted correctly.

The camera freezes Remove the battery and insert it again.

The camera heats up
While using the camera, it may heat up. This 
is normal and should not affect your camera’s 
lifespan or performance.

The flash fires 
unexpectedly

The flash may fire due to static electricity. The 
camera is not malfunctioning. 

The flash does not 
work

• The flash option may be set to Off. (p. 76)
• You cannot use the flash in some modes.

The date and time are 
incorrect

Set the date and time under the w menu.  
(p. 130)
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Situation Suggested remedies

The display or buttons 
do not work

Remove the battery and insert it again.

The memory card has 
an error

• Turn off your camera, and then turn it on 
again.

• Remove your memory card, and then insert it 
again.

• Format your memory card.
See "Cautions when using memory cards" for 
more details. (p. 155)

Your TV or computer 
cannot display photos 
and videos that are 
stored on an SDXC 
memory card.

SDXC memory cards use the exFAT file system.  
Ensure that the external device is compatible 
with the exFAT file system before connecting the 
camera to the device.

Your computer does 
not recognize an 
SDXC memory card.

SDXC memory cards use the exFAT file system.  
To use SDXC memory cards on a Windows XP 
computer, download and update the exFAT file 
system driver from the Microsoft website.

Cannot display files

If you change the name of a file, your camera 
may not play the file (the name of the file should 
meet the DCF standard). If you encounter this 
situation, display files on your computer.

Situation Suggested remedies

The photo is blurry

• Ensure that the focus option you set is 
suitable for the kind of shot you are capturing.

• Use a tripod to prevent your camera from 
shaking.

• Ensure that the lens is clean. If not, clean the 
lens. (p. 150)

The colors in the 
photo do not match 
the actual scene

An incorrect White Balance can create 
unrealistic color. Select the proper White 
Balance option to suit the light source. (p. 61)

The photo is too bright

Your photo is overexposed.
• Adjust the aperture value or the shutter 

speed.
• Adjust the ISO sensitivity. (p. 60)
• Turn off the flash. (p. 76)
• Adjust the exposure value. (p. 85)

The photo is too dark

Your photo is underexposed.
• Adjust the aperture value or the shutter 

speed.
• Adjust the ISO sensitivity. (p. 60)
• Turn on the flash. (p. 76)
• Adjust the exposure value. (p. 85)
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Situation Suggested remedies

Photos are distorted

This camera can have minute distortion when 
using a wide-angle lens that enables shooting 
with a wide angle of view. This is normal, and 
does not cause malfunction.

Playback screen does 
not appear on the 
connected external 
device

• Ensure that HDMI cable is properly connected 
to the external monitor.

• Ensure that the memory card is properly 
recorded.

Your computer does 
not recognize your 
camera

• Ensure that the USB cable is connected 
correctly.

• Ensure that your camera is switched on.
• Ensure that you are using a supported 

operating system.

Your computer 
disconnects the 
camera while 
transferring files

The file transfer may be interrupted by static 
electricity. Disconnect the USB cable and 
connect it again. 

Your computer cannot 
play videos

Depending on the software you use, video files 
may not play. To play video files captured with 
your camera, install and use the Intelli-studio 
program on your computer. (p. 141)

Intelli-studio is not 
functioning properly

• End Intelli-studio and restart the program.
• You cannot use Intelli-studio on Macintosh 

computers.

Situation Suggested remedies

Cannot set the DPOF 
for RAW files

You cannot set the DPOF for RAW files.

Auto Focus does not 
work

• Subject is not in focus. When the subject is 
outside the AF area, shoot by moving the 
subject inside the AF area and half pressing 
[Shutter].

• Subject is too close. Step back from the 
subject and shoot.

• The focus mode is set to MF. Switch the 
mode to AF.

AEL feature does not 
work

AEL feature does not work in t, M, i, 
g and s modes. Select another mode to 
use this feature.

Lens does not work
• Ensure that the lens is properly mounted. 
• Remove the lens from the camera and  

re-mount it.

External flash or GPS 
does not work

Ensure that the external device is properly 
mounted and turned on.

The date & time 
settings screen 
appears when you 
power on the camera

• Set the date and time again.
• This screen appears when the camera’s 

internal power source is completely 
discharged. Insert a fully charged battery and 
wait at least 72 hours in power off status for 
the internal power source to be recharged.
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Image Sensor

Type CMOS

Sensor size 23.5 X 15.7 mm

Effective pixels Approx. 20.3 mega-pixels

Total pixels Approx. 21.6 mega-pixels

Color filter RGB primary color filter

Lens Mount

Type Samsung NX Mount

Available lens Samsung lenses

Image Stabilization

Type Lens shift (depends on lens)

Mode Mode 1/Mode 2/Off

Distortion Correct

Lens Distortion Correct on/off (depends on lens)

i-Function

E (depends on lens), Z (X1.2, 1.4, 1.7, 2.0)

Dust Reduction

Type Super sonic drive

Display

Type TFT LCD

Size 3.0" (Approx. 7.6 cm)

Resolution VGA (640X480) Approx. 921 k dots

Field of view Approx. 100 %

User display Grid Line, Icons, Histogram, Distance Scale, 
Level gauge

Focusing

Type Contrast AF

Focusing point
• Selection: 1 point (free selection)
• Multi: Normal 15 points, Close up 35 points
• Face detection: Max. 10 faces 

Mode  Single AF, Continuous AF, Manual Focus

AF Assist Lamp Green LED

Shutter

Type Electronically controlled vertical-run focal plane 
shutter

Speed
• Auto: 1/4,000–30 sec.
• Manual: 1/4,000–30 sec. (1/3 EV Step)
• Bulb (time limit: 4 min.)
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Exposure

Metering system

TTL 221 (17 X 13) Block segment

Metering: Multi, Center-weighted, Spot

Metering range: EV 0–18 (ISO100 · 30 mm, F2)

Compensation ±3 EV (1/3 EV Step)

AE lock Custom button

ISO equivalent

• 1 Step: Auto, ISO 100, ISO 200, ISO 400,  
ISO 800, ISO 1600, ISO 3200, ISO 6400,  
ISO 12800

• 1/3 Step: Auto, ISO 100, ISO 125, ISO 160,  
ISO 200, ISO 250, ISO 320, ISO 400,  
ISO 500, ISO 640, ISO 800, ISO 1000,  
ISO 1250, ISO 1600, ISO 2000, ISO 2500, 
ISO 3200, ISO 4000, ISO 5000, ISO 6400, 
ISO 8000, ISO 10000, ISO 12800

Drive Mode

Mode
Single, Continuous, Burst (5M only), Timer, 
Bracket (Auto Exposure, White Balance,  
Picture Wizard)

Continuous shooting

• JPEG
 - High (8 fps): up to 11 shots possible
 - Low (3 fps): up to 15 shots possible

• RAW 
 - High (8 fps), Low (3 fps): up to 8 shots 

possible

Burst shooting
• 10, 15, or 30 frames per second
• Up to 30 shots per shutter-press

Bracket shooting
Auto exposure bracketing (±3 EV),  
White Balance bracketing,  
Picture Wizard bracketing

Self-timer 2–30 sec. (1 second interval)

Shutter release SR2NX02 (via Micro USB port) (optional)

Flash

Type External flash only (Bundle with SEF8A)

Mode Smart Flash, Auto, Auto Red-eye, Fill in,  
Fill-in Red, 1st Curtain, 2nd Curtain, Off

Guide number 8 (based on ISO 100)

Angle of view 28 mm (35 mm film equivalent)

Sync speed Less than 1/180 sec.

Flash EV -2–+2 EV (0.5 EV Step)

External flash Optional Samsung external flashes:  
SEF42A, SEF220A

Sync terminal Hot-shoe

White Balance

Mode

Auto WB, Daylight, Cloudy, Fluorescent White, 
Fluorescent NW, Fluorescent Daylight, Tungsten, 
Flash WB, Custom Set, Color Temperature 
(Manual)

Micro adjustment Amber/Blue/Green/Magenta 7 steps 
respectively



163

Appendix > Camera specifications

Smart Range

Smart Range On/Off

Picture Wizard

Mode
Standard, Vivid, Portrait, Landscape, Forest, 
Retro, Cool, Calm, Classic, Custom1, Custom2, 
Custom3

Parameter Contrast, Sharpness, Saturation, Color

Shooting

Mode
Smart Auto, Program, Aperture Priority,  
Shutter Priority, Manual, Lens Priority, Magic, 
Scene, Movie, Wi-Fi

Scene mode

Panorama (Live Panorama, 3D), Beauty Shot, 
Night, Landscape, Portrait, Children, Sports, 
Close Up, Text, Sunset, Dawn, Backlight, 
Fireworks, Beach & Snow, 3D

Smart Filter
Vignetting, Miniature, Fish Eye, Sketch, Defog, 
Halftone Dots, Soft Focus, Old Film 1,  
Old Film 2, Negative

Magic Frame

Old Album, Old Film, Wave, Full Moon,  
Old Record, Magazine, Newspaper,  
Sunny Day, Classic TV, Wall Art, Holiday, 
Billboard 1, Billboard 2

Selective Color Red, Green, Blue, Yellow

Size

• JPEG (3:2): 20.0M (5472X3648)20.0M 
(5472X3648),  
10.1M (3888X2592), 5.9M (2976X1984),  
5.0M (2736X1824) (Burst mode only),  
2.0M (1728X1152)

• JPEG (16:9): 16.9M (5472X3080),  
7.8M (3712X2088), 4.9M (2944X1656),  
2.1M (1920X1080)

• JPEG (1:1): 13.3M (3648X3648),  
7.0M (2640X2640), 4.0M (2000X2000),  
1.1M (1024X1024)

• RAW: 20.0M (5472X3648)

Quality Super Fine, Fine, Normal

RAW standard SRW

Color space sRGB, Adobe RGB

Video

Type MP4 (H.264)

Format Movie: H.264, Sound: AAC

Movie AE mode Program, Aperture Priority, Shutter Priority, 
Manual 
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Movie clip Audio on/off (Shooting time: up to 25 min)

Smart Filter
Vignetting, Miniature, Fish Eye, Sketch, Defog, 
Halftone Dots, Soft Focus, Old Film 1,  
Old Film 2, Negative

Size 1920X1080, 1920X810, 1280X720, 640X480, 
320X240 (For Sharing)

Frame rate 30 or 24 frames per second  
(24 fps is available only with 1920X810.)

Multi Motion
x0.25 (640X480, 320X240 only),  
x0.5 (1280X720, 640X480, 320X240 only),  
x1, x5, x10, x20 

Quality HQ, Normal

Sound Stereo 

Edit Still image capture, Time trimming

Playback

Type Single image, Thumbnails (3/15/40),  
Slide show, Movie

Edit
Smart Filter, Red-eye Fix, Backlight, Resize, 
Rotate, Face Retouch, Brightness, Contrast, 
Vignetting

Smart filter
Miniature, Soft Focus, Old Film 1, Old Film 2,  
Halftone Dots, Sketch, Fish Eye, Defog, 
Negative 

Smart filter size

• JPEG (3:2): 5.9M (2976X1984),  
5.0M (2736X1824), 2.0M (1728X1152)

• JPEG (16:9): 6.2M (3328X1872),  
4.9M (2944X1656), 2.1M (1920X1080)

• JPEG (1:1): 6.0M (2448X2448),  
4.0M (2000X2000), 1.1M (1024X1024)

Storage

Media

External memory (optional):  
SD card (up to 1–2 GB guaranteed),  
SDHC card (up to 32 GB guaranteed),  
SDXC card (up to 128 GB guaranteed) 

File format RAW (SRW), JPEG (EXIF 2.21), DCF,  
DPOF 1.1, PictBridge 1.0

Direct Printing

PictBridge

GPS

Type Geo-tagging with optional GPS Module  
(WGS 84)

Feature
• Location name (English and Korean only)
• Google Map link (with Intelli-studio)
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Wireless network

Type IEEE 802.11n supported

Function
Social Sharing, Email, MobileLink,  
Remote Viewfinder, SkyDrive, Auto Backup,  
TV Link, Wi-Fi Direct

Interface

Digital output USB 2.0 (HI-SPEED) (micro USB jack)

Video output
NTSC, PAL (selectable)
HDMI 1.4a: (1080i, 720p, 576p/480p)

External release Included (micro USB)

External microphone Included

Power Source

Type

• Rechargeable battery: BP1030 (1,030 mAh)
• Charger: BC1030
*   The power source may differ depending on 

your region.

Dimensions (W X H X D)

114 X 62.5 X 37.5 mm (without protrusions)

Weight

222 g (without battery and memory card)

Operating Temperature

0–40 °C

Operating Humidity

5–85 %

Software

Intelli-studio, Samsung RAW Converter, PC Auto Backup

* This specifications can change without notice to upgrade a performance. 
* Other brands and products names are trademarks of respective owners.
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AP (Access Point)

An access point is a device that allows wireless devices to connect to a 
wired network.

Ad-Hoc network

An ad-hoc network is a temporary connection for sharing files or an 
internet connection and between computers and devices.

AdobeRGB

Adobe RGB is used for commercial printing and has a larger color range 
than sRGB. Its wider range of colors helps you to easily edit photos on a 
computer.

AEB (Auto Exposure Bracket)

This feature automatically captures several images at different exposures 
to help you capture a properly-exposed image.

AEL (Auto Exposure Lock)

This feature helps you lock the exposure on which you want to calculate 
the exposure.

AF (Auto Focus)

A system that automatically focuses the camera lens on the subject. 
Your camera uses the contrast to focus automatically.

AMOLED (Active-matrix organic light-emitting diode) /  
LCD (Liquid Crystal Display)

AMOLED is a visual display that is very thin and light, as it does not 
need backlighting. LCD is a visual display commonly used in consumer  
electronics. This display needs a separate backlight, such as CCFL or 
LED, to reproduce colors.

Aperture

The aperture controls the amount of light that reaches the camera’s 
sensor.
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Composition

Composition in photography means arranging objects in a photo. 
Usually, abiding by the rule of thirds leads to a good composition.

DCF (Design rule for Camera File system)

A specification to define a file format and file system for digital cameras 
created by the Japan Electronics and Information Technology Industries 
Association (JEITA). 

Depth of field

The distance between the nearest and farthest points that can be 
acceptably focused in a photograph. Depth of field varies with lens 
aperture, focal length, and distance from the camera to the subject. 
Selecting a smaller aperture, for example, will increase the depth of field 
and blur the background of a composition.

DPOF (Digital Print Order Format)

A format for writing printing information, such as selected images 
and number of prints, on a memory card. DPOF-compatible printers, 
sometimes available at photo shops, can read the information from the 
card for convenient printing.

Camera shake (Blur)

If the camera is moved while the shutter is open, the entire image may 
appear blurred. This occurs more often when the shutter speed is slow. 
Prevent camera shake by raising the sensitivity, using the flash, or using 
a faster shutter speed. Alternatively, use a tripod or the OIS function to 
stabilize the camera.

Cloud Computing

Cloud computing is a technology that allows you to store data on 
remote servers and to use them from a device with internet access. 

Color space

The range of colors that the camera can see.

Color temperature

Color Temperature is a measurement in degrees Kelvin (K) that indicates 
the hue of a specific type of light source. As the color temperature 
increases, the color of the light source has a more bluish quality. As the 
color temperature decreases, the color of the light source has a more 
reddish quality. At 5,500 degrees Kelvin, the color of the light source is 
similar to the sun at midday.
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Flash

A speed light that helps to create adequate exposure in low-light 
conditions.

Focal length

The distance from the middle of the lens to its focal point(in millimeters). 
Longer focal lengths result in narrower angles of view and the subject is 
magnified. Shorter focal lengths result in wider angles of view.

Histogram

A graphical representation of the brightness of an image. The horizontal 
axis represents the brightness and the vertical axis represents the 
number of pixels. High points at the left (too dark) and right (too bright) 
on the histogram indicate a photo that is improperly exposed.

EV (Exposure Value)

All the combinations of the camera’s shutter speed and lens aperture 
that result in the same exposure. 

EV Compensation

This feature allows you to quickly adjust the exposure value measured 
by the camera, in limited increments, to improve the exposure of your 
photos.

Exif (Exchangeable Image File Format)

A specification to define an image file format for digital cameras created 
by the Japan Electronic Industries Development Association (JEIDA).

Exposure

The amount of light allowed to reach the camera’s sensor. Exposure is 
controlled by a combination of the shutter speed, the aperture value, 
and ISO sensitivity.



169

Appendix > Glossary

JPEG (Joint Photographic Experts Group)

A lossy method of compression for digital images. JPEG images are 
compressed to reduce their overall file size with minimal deterioration of 
the image resolution. 

Metering

The metering refers to the way in which the camera measures the 
quantity of light to set the exposure.

MF (Manual Focus)

A system that manually focuses the camera lens on the subject. You 
can use the focus ring to focus on a subject.

MJPEG (Motion JPEG)

A video format which is compressed as a JPEG image.

MPO (Multi Picture Object)

An image file format that contains multiple images in a file. An MPO file 
provides a 3D effect on MPO-compatible displays, such as 3D TVs or 
3D monitors.

H.264/MPEG-4

A high-compression video format established by international standard 
organizations ISO-IEC and ITU-T. This codec is capable of providing 
good video quality at low bit rates developed by the Joint Video Team 
(JVT).

Image sensor

The physical part of a digital camera that contains a photosite for each 
pixel in the image. Each photosite records the brightness of the light 
that strikes it during an exposure. Common sensor types are CCD 
(Charge-coupled Device) and CMOS (Complementary Metal Oxide 
Semiconductor).

IP (Internet protocol) address

An IP address is a unique number that is assigned to every device that 
is connected to the internet.

ISO sensitivity

The sensitivity of the camera to light, based on the equivalent film speed 
used in a film camera. At higher ISO sensitivity settings, the camera 
uses a higher shutter speed, which can reduce blur caused by camera 
shake and low light. However, images with high sensitivity are more 
susceptible to noise.
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Quality

An expression of the rate of compression used in a digital image. Higher 
quality images have a lower rate of compression, which usually results in 
a larger file size.

RAW (Sensor raw data)

The original, unprocessed data, collected directly from the camera’s 
image sensor. White Balance, contrast, saturation, sharpness, and 
other data can be manipulated with editing software before the image is 
compressed into a standard file format.

Resolution

The number of pixels present in a digital image. High resolution images 
contain more pixels and typically show more detail than low resolution 
images.

Noise

Misinterpreted pixels in a digital image that may appear as misplaced or 
random, bright pixels. Noise usually occurs when photos are shot with a 
high sensitivity or when a sensitivity is automatically set in a dark place.

NTSC (National Television System Committee) 

A video color encoding standard used most commonly in Japan, North 
America, the Philippines, South America, South Korea, and Taiwan.

Optical zoom

This is a general zoom which can enlarge images with a lens and does 
not deteriorate quality of images.

PAL (Phase Alternate Line)

A video color encoding standard used in numerous countries throughout 
Africa, Asia, Europe, and the Middle East.
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Shutter speed

Shutter speed refers to the amount of time it takes to open and close 
the shutter, and it is an important factor in the brightness of a photo, as 
it controls the amount of light which passes through the aperture before 
it reaches the image sensor. A fast shutter speed allows less time to let 
light in and the photo becomes darker and more easily freezes subjects 
in motion.

sRGB (Standard RGB)

International standard of colour space established by the IEC 
(International Electrotechnical Commission). This is defined from colour 
space for PC monitors and is also used as the standard colour space 
for Exif.

Vignetting

A reduction of an image’s brightness or saturation at the periphery 
(outer edges) compared to the center of the image. Vignetting can draw 
interest to subjects positioned in the center of an image.

White Balance (Color balance)

An adjustment of the intensities of colors (typically the primary colors 
red, green, and blue), in an image. The goal of adjusting the White 
Balance, or color balance, is to correctly render the colors in an image.

Wi-Fi

Wi-Fi is a technology that allows electronic devices to exchange data 
wirelessly over a network.

WPS (Wi-Fi Protected Setup)

WPS is a technology that secures wireless home networks.
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Lens

SAMSUNG 18-55 mm 
F3.5-5.6 OIS III

SAMSUNG 20-50 mm 
F3.5-5.6 ED II

SAMSUNG 16 mm F2.4 SAMSUNG 20 mm F2.8

SAMSUNG 30 mm F2 SAMSUNG 50-200 mm 
F4-5.6 ED OIS II

SAMSUNG 60 mm F2.8 
Macro ED OIS SSA

SAMSUNG 18-200 mm 
F3.5-6.3 ED OIS

Lens

SAMSUNG 85 mm F1.4 ED SSA

External flash

SEF42A SEF220A

GPS

GPS10
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Other accessories

Camera bag
You can purchase the camera bag separately.

Camera case
You can purchase the camera case separately.

Memory card
This product supports SD (Secure Digital),  
SDHC (Secure Digital High Capacity),  
SDXC (Secure Digital eXtended Capacity), 
microSD, microSDHC, or microSDXC memory 
cards.

Filter
You can create different colored effects by 
attaching filters to your lens.

USB cable
You can purchase additional USB cables.

HDMI cable
You can view high-definition photos and 
videos by connecting the camera to an HDMI-
compatible monitor with the HDMI (HDMI type D) 
cable.

Other accessories

Shutter release (micro USB type)
Shutter release reduces shakiness when used 
with a tripod.

Zoom microphone
Zoom microphone picks up the subject's sound 
more clearly when you record a video with the 
zoom function.

Strap
You can additionally purchase the straps.

Battery pack
You can purchase additional battery packs.

Quick battery charger
You can purchase an optional quick battery 
charger.

• These illustrations may differ from your actual items. Refer to the user 
manuals of these optional accessories for details. 

• Use only Samsung-approved accessories. Samsung is not responsible for 
damage caused by using another manufacturer’s accessories.
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A

Aperture  14, 18

Auto Backup  116

Auto focus  65

B

Battery
Life  157
Specifications  156

Bracketing  72, 74

C

Camera
Connecting as removable disk  139
Connecting to PC  139
Disconnecting (Windows)  140
Layout  28

Color space  84

Custom button  127

D

Depth of Field (DOF)  15, 20

Digital Print Order Format  
(DPOF)  137

Drive (see Shooting method)  72

E

E-mail  111

Exposure Value (EV)  15, 85

F

Fader  88

Files
Deleting  92
Editing RAW format  146
Photo format  59
Protecting  92
Transferring to Mac  140
Transferring to PC  139
Video format  59

Flash
Bounce photography  25
Flash options  76
Guide number  24
Intensity  77

F-number  15

Focal length  19

G

Glossary  166

I

i-Function  48

Intelli-Studio  142

ISO sensitivity  17, 18, 60

i-Zoom  49

L

Lenses
Locking  36
Markings  37
Unlocking  36

M

Maintenance  150

Memory card  153

Metering  79

MF assist  70

O

Optical Image Stabilization  
(OIS)  71

Optional accessories
Attach the GPS module  41
Flash layout  38
GPS module layout  41

Index
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P

Photos
Adjusting tone  147
Editing  98
Enlarging  94
Shooting options  57
Viewing on 3D TV  135
Viewing on camera  90
Viewing on HDTV  134

Photo styles  64

PictBridge  136

Picture Wizard  64

Posture  13

R

Red-eye effect  77

Remote Viewfinder  107

Rule of thirds  22

S

Samsung RAW Converter  145

Shooting method  72

Shooting modes
Aperture Priority  45
Lens Priority  47
Manual  46
Movie  54
Program  44
Scene  51
Shutter Priority  45
Smart Auto  43

Shutter speed  16, 18

Slide show  94

Smart Album  91

Smart Range  82

T

Timer  73

TV Link  118

V

Videos
Options  87
Viewing  96

W

Wireless network  101

3

3D Shot  53
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Correct Disposal of This Product  
(Waste Electrical & Electronic Equipment)

(Applicable in the European Union and other European 
countries with separate collection systems) 

This marking on the product, accessories or literature indicates that 
the product and its electronic accessories (e.g. charger, headset, USB 
cable) should not be disposed of with other household waste at the 
end of their working life. To prevent possible harm to the environment 
or human health from uncontrolled waste disposal, please separate 
these items from other types of waste and recycle them responsibly to 
promote the sustainable reuse of material resources. Household users 
should contact either the retailer where they purchased this product, 
or their local government office, for details of where and how they can 
take these items for environmentally safe recycling. Business users 
should contact their supplier and check the terms and conditions of the 
purchase contract. This product and its electronic accessories should 
not be mixed with other commercial wastes for disposal.

Correct disposal of batteries in this product

(Applicable in the European Union and other European 
countries with separate battery return systems)

This marking on the battery, manual or packaging indicates that the 
batteries in this product should not be disposed of with other household 
waste at the end of their working life. Where marked, the chemical 
symbols Hg, Cd or Pb indicate that the battery contains mercury, 
cadmium or lead above the reference levels in EC Directive 2006/66. 
If batteries are not properly disposed of, these substances can cause 
harm to human health or the environment. 

To protect natural resources and to promote material reuse, please 
separate batteries from other types of waste and recycle them through 
your local, free battery return system.

This Class [B] digital apparatus complies with Canadian ICES-003.

Dispose unwanted electronics through an approved recycler. 
To find the nearest recycling location, go to our website: 
www.samsung.com/recyclingdirect Or call, (877) 278 - 0799

Appendix
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FCC notice

Caution:
Any changes or modifications in construction of this device which are not 
expressly approved by the party responsible for compliance could void the 
user's authority to operate the equipment.

NOTE:
This equipment has been tested and found to comply with the limits for 
a Class B digital device, pursuant to part 15 of the FCC Rules. These 
limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses 
and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will 
not occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures:
• Reorientate, or relocate, the receiving antenna.
• Increase the distance between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to 

which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

Declaration of Conformity 
Trade Name : Samsung Electronics America, Inc. 

Model No.  : Samsung NX1000

Responsible Party : Samsung Electronics America, Inc.

Address : 85 Challenger Road, Ridgefield Park, NJ 07660  

Telephone No. : 1-800-SAMSUNG (726-7864)

This device complies with Part 15 of the FCC Rules.  
Operation is subject to the following two conditions:   
(1) This  device may not cause harmful interference, and (2) this device 
must accept any interference received, including interference that may 
cause undesired operation.

This device complies with part 15 of the FCC Rules. Operation is subject 
to the following two conditions: (1) This device may not cause harmful 
interference, and (2) this device must accept any interference received, 
including interference that may cause undesired operation.

RF exposure statements:
This device is for handheld operation only. The antenna(s) used for this 
transmitter must be installed to provide a separation distance of at least 
20 cm from all persons and must not be co-located or operating in 
conjunction with any other antenna or transmitter.

FCC ID:A3LNX1000

katie_gu
스탬프
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CAUTION
RISK OF EXPLOSION IF BATTERY IS REPLACED BY  

AN INCORRECT TYPE. 
DISPOSE OF USED BATTERIES ACCORDING 

TO THE INSTRUCTIONS

Operation is subject to the following two conditions:

(1) This device may not cause harmful interference, and  
(2) This device must accept any interference received,  
including interference that may cause undesired operation.

Caution:

Any changes or modifications to the equipment not expressly 
approved by the party responsible for compliance could void 
user’s authority to operate the equipment. 
IC: 649E-NX1000

This equipment may be operated in all EU countries.

In France, this equipment may only be used indoors.

Complies with 
IDA Standards 

DA100790

NO-L-14041/01/2011/ETA/2011
1577/2011/WRLO

Approved by PTA, 
year 2011

TA-2011/1257 
APPROVED

No.: ESD-1105767C

katie_gu
스탬프
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and the Eco-Design Directive (2009/125/EC) implemented by 
Regulations (EC) No 278/2009 for external power supplies.

 Representative in the EU

Samsung Electronics Euro QA Lab. 
Blackbushe Business Park 
Saxony Way, Yateley, Hampshire 
GU46 6GG, UK

(YEAR TO BEGIN AFFIXING CE MARKING 2012)

5 April, 2012

(Place and date of issue)

Joong-Hoon Choi / Lab. Manager

(Name and signature of authorized person)

*  This is not the address of Samsung Service Centre. For the 
address or the phone number of Samsung Service Centre, see 
the warranty card or contact the retailer where you purchased 
your product.

 Product details

For the following

Product :  DIGITAL CAMERA

Model(s) :  NX1000

 Declaration & Applicable standards

We hereby declare that the product(s) above is(are) in compliance 
with the essential requirements and other provisions of the R&TTE 
Directive (1999/5/EC), the Low Voltage Directive (2006/95/EC) 
and the Electromagnetic Compatibility Directive (2004/108/EC) by 
application of:

EN 60950-1:2006+A1:2010 EN 55024:1998+A1:2001+A2:2003

EN 55022:2006+A1 :2007 EN 61000-3-2:2006 +A1:2009 +A2:2009

EN 61000-3-3:2008 EN 300 328 v1.7.1

EN 301 489-1 v1.8.1 EN 301 489-17 V2.1.1

EN62311 :2008
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Declaration sentence in official languages

Nation Declaration

Cesky Samsung Electronics tímto prohlašuje, že tento digitální fotoaparát je ve shodě se základními požadavky a dalšími příslušnými 
ustanoveními směrnice 1999/5/ES.

Dansk Samsung Electronics erklærer herved, at digitale kameraer overholder de væsentlige krav og øvrige relevante krav i direktiv 1999/5/
EF.

Deutsch Hiermit erklärt Samsung Electronic, dass sich die Digitalkamera in Übereinstimmung mit den grundlegenden Anforderungen und den 
übrigen einschlägigen Bestimmungen der Richtlinie 1999/5/EG befindet.

Eesti Käesolevaga kinnitab Samsung Electronics digitaalkaamera vastavust direktiivi 1999/5/EÜ põhinõuetele ja nimetatud direktiivist 
tulenevatele teistele asjakohastele sätetele.

English Hereby, Samsung Electronics declares that this digital camera is in compliance with the essential requirements and other relevant 
provisions of Directive 1999/5/EC.

Español Por medio de la presente Samsung Electronics declara que la cámara digital cumple con los requisitos esenciales y cualesquiera 
otras disposiciones aplicables o exigibles de la Directiva 1999/5/CE.

Ελληνική ΜΕ ΤΗΝ ΠΑΡΟΥΣΑ η Samsung Electronics ΔΗΛΩΝΕΙ ΟΤΙ η ψηφιακή φωτογραφική μηχανή ΣΥΜΜΟΡΦΩΝΕΤΑΙ ΠΡΟΣ ΤΙΣ 
ΟΥΣΙΩΔΕΙΣ ΑΠΑΙΤΗΣΕΙΣ ΚΑΙ ΤΙΣ ΛΟΙΠΕΣ ΣΧΕΤΙΚΕΣ ΔΙΑΤΑΞΕΙΣ ΤΗΣ ΟΔΗΓΙΑΣ 1999/5/ΕΚ.

Français Par la présente Samsung Electronic déclare que l'appareil photo numérique est conforme aux exigences essentielles et aux autres 
dispositions pertinentes de la directive 1999/5/CE.

Italiano Con la presente Samsung Electronicsdichiara che questa fotocamera digitale è conforme ai requisiti essenziali e alle altre 
disposizioni stabilite dalla Direttiva 1999/5/CE.

Latviski Ar šo Samsung Electronics deklarē, ka digitālā kamera atbilst Direktīvas 1999/5/EK būtiskajām prasībām un citiem ar to saistītajiem 
noteikumiem.

Lietuvių Šiuo Samsung Electronics deklaruoja, kad šis skaitmeninis fotoaparatas, atitinka esminius reikalavimus ir kitas 1999/5/EB Direktyvos 
nuostatas.

Nederlands Hierbij verklaart Samsung Electronics dat de digitale camera in overeenstemming is met de essentiële eisen en de andere relevante 
bepalingen van richtlijn 1999/5/EG.

Malti Hawnhekk, Samsung Electronics, tiddikjara li din il-kamera diġitali hi konformi mar-rekwiżiti essenzjali u ma' dispożizzjonijiet rilevanti 
oħrajn ta' Direttiva 1999/5/KE.
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Nation Declaration

Magyar A Samsung Electronics kijelenti, hogy ez a digitális fényképezőgép megfelel az 1999/5/EK irányelv alapvetõ követelményeinek és 
egyéb vonatkozó elõírásainak.

Polski Niniejszym firma Samsung Electronics oświadcza, że ten aparat cyfrowy jest zgodny z zasadniczymi wymogami oraz pozostałymi 
stosownymi postanowieniami Dyrektywy 1999/5/WE.

Português Samsung Electronics declara que esta câmera digital está conforme os requisitos essenciais e outras disposições da Directiva 
1999/5/CE.

Slovensko Samsung Electronics izjavlja, da je ta digitalni fotoaparat v skladu z bistvenimi zahtevami in ostalimi relevantnimi določili direktive 
1999/5/ES.

Slovensky Samsung Electronics týmto vyhlasuje, že tento digitálny fotoaparát spĺňa základné požiadavky a všetky príslušné ustanovenia 
Smernice 1999/5/ES.

Suomi Samsung Electronics vakuuttaa täten että tämä digitaalikamera on direktiivin 1999/5/EY oleellisten vaatimusten ja sitä koskevien 
direktiivin muiden ehtojen mukainen.

Svenska Härmed intygar Samsung Electronicsatt dessa digitalkameror står i överensstämmelse med de väsentliga egenskapskrav och övriga 
relevanta bestämmelser som framgår av direktiv 1999/5/EG.

Български С настоящото Samsung Electronics декларира, че този цифров фотоапарат е в съответствие със съществените изисквания и 
другите приложими разпоредби на Директива 1999/5/ЕК.

Română Prin prezenta, Samsung Electronics, declară că această cameră foto digitală este în conformitate cu cerinţele esenţiale şi alte 
prevederi relevante ale Directivei 1999/5/CE.

Norsk Samsung Electronicserklærer herved at dette digitalkameraet er i samsvar med de grunnleggende krav og øvrige relevante krav i 
direktiv 1999/5/EF.

Türkiye Bu belge ile, Samsung Electronics bu dijital kameranın 1999/5/EC Yönetmeliginin temel gerekliliklerine ve ilgili hükümlerine uygun 
olduğunu beyan eder.

Íslenska Hér með lýsir Samsung Electronics því yfir að þessi stafræna myndavél sé í samræmi við grunnkröfur og önnur ákvæði tilskipunar 
1999/5/EB.



Please refer to the warranty that came with your product  
or visit our website www.samsung.com for after-sales service or inquiries.

www.samsung.com



